Table of Contents

1. Introduction
   System Overview ......................................................................................................... 1-1
   Basic Database Terminology ................................................................................. 1-1
   Program Installation ................................................................................................. 1-2
     DDMSW ................................................................................................................. 1-2
     Acrobat Reader ...................................................................................................... 1-2
     Windows Regional Settings .................................................................................... 1-3
   Starting the Software ............................................................................................... 1-3

2. General Features
   Main Menu .................................................................................................................... 2-1
   Standard Buttons .......................................................................................................... 2-1
   Edit Menu ..................................................................................................................... 2-3
   Forms ........................................................................................................................... 2-3

3. File
   New ............................................................................................................................... 3-1
   Open ............................................................................................................................. 3-2
   Edit ................................................................................................................................ 3-2
   Management ................................................................................................................. 3-3
   Setup ............................................................................................................................ 3-5

4. Hydrology
   Rainfall .......................................................................................................................... 4-1
     Prefre ......................................................................................................................... 4-1
     Rainfall Pattern ........................................................................................................... 4-1
     6 Hour Distribution Defaults .................................................................................... 4-2
     IDF Parameters ......................................................................................................... 4-2
   Soils ................................................................................................................................ 4-2
     Data ........................................................................................................................... 4-2
     Defaults ..................................................................................................................... 4-3
     Soil Surveys ................................................................................................................ 4-3
   Land Use ...................................................................................................................... 4-4
     Data ........................................................................................................................... 4-4
     Defaults ..................................................................................................................... 4-4
   Basins ............................................................................................................................. 4-5
     Major Basins .............................................................................................................. 4-5
     Sub Basins .................................................................................................................. 4-5
   Routing .......................................................................................................................... 4-6
   Distributions .................................................................................................................. 4-7
     Time-Area .................................................................................................................... 4-7
     S-Graph ...................................................................................................................... 4-7
   HEC-1 ............................................................................................................................. 4-8
     Run HEC-1 ................................................................................................................... 4-8
     Edit HEC-1 Data ........................................................................................................ 4-9
     View Summary Results ............................................................................................. 4-9
     View Output File ........................................................................................................ 4-10
     Develop Draft Model Data ....................................................................................... 4-10

5. Hydraulics
   To be developed
Table of Contents (Cont’d)

6. **GIS**
   To be developed

7. **Utilities**
   Export Data .................................................................................................................................... 7-1
   Import Data ................................................................................................................................... 7-2
   Pack Tables .................................................................................................................................. 7-3
   Table Descriptions ....................................................................................................................... 7-3
   Field Descriptions ....................................................................................................................... 7-3
   Import DOS Family ...................................................................................................................... 7-4

8. **Help and Window**
   Help ............................................................................................................................................... 8-1
   Window .......................................................................................................................................... 8-1

**Example**
   HEC-1 model ................................................................................................................................. Ex-1
1. Introduction

System Overview

The Drainage Design Management System for Windows (DDMSW) has been written to facilitate data management and computational procedures required for drainage analysis in Maricopa County. This manual serves as a guide in the use of the program and is intended to be used in conjunction with the County’s Drainage Design Manuals.

The program is written in Microsoft Visual FoxPro and currently includes modules for File Management, Hydrology and Utilities. Future versions will include modules for Hydraulics and GIS (Geographic Information System) integration.

Unlike the former DDMS which was DOS based and stored data in separate ASCII files, DDMSW is a relational Database that manages multiple projects from one single location. DDMSW is a multi-tasking window based application which enables the user to open several ‘windows’ simultaneously. New features include pull-down menus, user-friendly forms which the user can arrange on the desktop, and windows editing tools to facilitate data entry. DDMSW utilizes a relational Database that includes Tables for data entry and editing. Each Table appears as a separate ‘.dbf’ file on disk. The Tables are related to each other based on the key field ‘Project Id’ which is established when starting a new project. Running models is automated from a menu and the data for running the models is extracted from the various Tables in the Database.

Basic Database Terminology

The application stores data (values) in a relational Database. This data is organized into tables, fields, and records to make it more meaningful. For example, 01 by itself is meaningless. However, in a table called ‘Basins’, in a field called ‘BasinId’, in a record corresponding to ‘KVLTEST1’, we now understand that 01 is a major basin in project KVLTEST1.

A table is a grouping of data. The data is dynamic because it can be modified, deleted, added to, and so on. Here is an example of a table:

Table: Basins

<table>
<thead>
<tr>
<th>ProjectID</th>
<th>BasinID</th>
<th>Description</th>
<th>Sort</th>
</tr>
</thead>
<tbody>
<tr>
<td>KVLTEST1</td>
<td>01</td>
<td>Major Basin 01</td>
<td>10</td>
</tr>
<tr>
<td>KVLTEST1</td>
<td>02</td>
<td>Major Basin 02</td>
<td>20</td>
</tr>
</tbody>
</table>

A table is composed of one or more fields. In the example, the fields are ProjectID, BasinID, Description, and Sort. Fields are similar to columns in a spreadsheet. All fields in a table have the same format (eg. text of maximum 70 characters, numeric 12 places with 2 decimals) and they share the same characteristics (eg. they are different descriptions).
A table also consists of one or more records. Records are similar to rows in a spreadsheet. In the example, "KVLTEST1, 01, Major Basin 01, 10’ compose one record in the table ‘Basins’. The example shows a total of two records and four fields.

In DDMSW, the Database is composed of numerous tables which organize and store information. These tables are linked by one common key field, projectid which identifies the project the records are associated with.

Program Installation

DDMSW

The software used in DDMSW includes:

- DDMSW Compiled application
- HEC-1 Most recent HEC-1 with modifications
- Prefre Rainfall model
- MCUHP1 County's DOS program
- MCUHP2 County's DOS program
- Rational County's DOS program
- WordPad Text editor (supplied by Windows)

All required software for DDMSW is contained on the CD provided with this application.

Insert the DDMSW CD in the CD drive (here denoted as X). Run X:\DDMSW\Setup from the RUN command (substitute your CD drive letter for X). Follow the instructions on the screen.

The user can choose the program’s location, but assuming C:\DDMSW, the following directory structure will be created:

- C:\DDMSW Program files
- C:\DDMSW\Adobe Adobe Acrobat installation files
- C:\DDMSW\Backup Directory for archiving data
- C:\DDMSW\Data Data Files
- C:\DDMSW\Help Help files
- C:\DDMSW\ModelRuns Default directory for model runs
- C:\DDMSW\Models Model programs
- C:\DDMSW\Reports Reports

The procedure will notify the user when the DDMSW installation is complete.

Adobe Acrobat Reader

This manual and all help files require Adobe Acrobat Reader to view and print the files. If Adobe Acrobat Reader is not currently installed on your computer, then it will be necessary to install the program. The latest version can be downloaded from Adobe’s website at WWW.Adobe.Com. Follow their instructions to download ‘Acrobat Reader’. Alternatively, a copy has been included in the Adobe sub directory of this installation. Double click on the program file and follow the instructions on the screen.
Windows Regional Settings

To ensure that printed reports contain the necessary number of decimal places, it is necessary to modify the regional Settings in the Windows Control Panel as follows:

Open Regional Settings (found in Control Panel) and click on 'Number'. Change “No of digits after decimal” to 5 and then click Apply.

Starting the Software

DDMSW is started by running ‘DDMSW.exe’. The program can be accessed from the Windows Startup menu or other selected folder or by double-clicking on the icon.

When the software is first started, it is necessary to edit File\Setup to establish system settings.
2. General Features

Main Menu

The Main Menu is the center of the application. This is the screen which is displayed when the user starts the application. This is also the screen the user is always returned to after closing a submenu or form.

Specific actions can be accessed through the pull-down menus shown on the Main Menu bar. This manual will explain the functions available on each menu and will describe the individual elements shown on data entry screens.

Standard Buttons

There is a toolbar of standard buttons, which is identical on each data entry screen.

- Goes to the first record in the table.
- Moves to the previous record.
- Moves to the next record.
- Goes to the last record in the table.
- Locates records based on a specified search criterion. Highlight the field to search and type the search expression.
Selects a subset of records according to user specifications. A filter consists of one or more conditions which compares a field to a value using an operator. Multiple conditions can be combined together with a connector. To create a filter, select the ‘Add’ button. The following ‘Filter Condition’ dialog box appears.

Select a field and an operator, enter a value and click ‘OK’. (For alphanumeric fields, select a value from the pull down list).

On the ‘Filter’ dialog box, the user has the following options:

i) Click ‘OK’ to execute the filter and view the subset of records.
ii) Select ‘Add’ again to add other condition to the filter.
iii) Select ‘Store’ to save the filter for future use. This is useful for commonly used filters.

To use a previously saved filter, select ‘Retrieve’. Highlight the filter on the ‘Select Filter’ dialog box and click ‘OK’. Click ‘OK’ on the ‘Filter’ dialog box to execute the command.

To edit a filter, retrieve it from the list, and choose ‘Edit’ or double-click on the condition. After changing any of the items that make up the condition, select ‘Store’ and ‘OK’ to save the changes.

Adds a new record.
Marks the current record for deletion. Marked records are physically deleted from disk when the Table is packed. The record will no longer appear but still exists until the Table is packed.

Closes the current form and returns the user to the Main Menu or previous form. Any changes made to the record are saved. Pressing [Esc] will also close the form and return the user to the previous screen. However, changes to the current record may not take effect.

**Edit Menu**

The Edit menu is available to the user during data entry or editing. The menu comprises the following functions. Some or all may be available depending on the action currently being executed.

- **Undo**  Undo the last change made to a field.
- **Cut**  Cut out (move) the highlighted text to the clipboard.
- **Copy**  Copy the highlighted text to the clipboard.
- **Paste**  Paste the text from the clipboard into the current field.

**Forms**

Some forms are composed of several tabs to view data. Click on the tab for the appropriate view.
The selection of New from the File Menu is used to create a new project. It is necessary to fill in the Project ID, Title and the path to the model runs on the Title form. The Project ID will be used throughout the application for all files that refer to this project. Model runs for all projects will have the same naming convention. It is therefore necessary to **establish separate folders for each project's model runs**. Create the folder using Windows Explorer and then use the button to locate the folder.

When finished with the Title data, enter the Hydrology default data. The Hydrology view varies depending on which model is selected.
Open

To open an existing project, make a selection from the drop down list.

Edit

The selection of Edit from the File Menu is used to edit an existing project. All data on this form can be modified except the Project ID. If it is necessary to change the Project ID, “Rename” the project in Management. If default data is changed, make sure that the appropriate data on other forms is also modified. For example, if the reach routing method is changed from “Normal Depth” to “Kinematic Wave”, it will be necessary to modify the routing data.
### Management

The Management menu offers the following functions:

#### Copy a Project

<table>
<thead>
<tr>
<th>Action</th>
<th>Project Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Project</td>
<td></td>
</tr>
<tr>
<td>Delete Project</td>
<td></td>
</tr>
<tr>
<td>Rename Project</td>
<td></td>
</tr>
<tr>
<td>Backup Project</td>
<td></td>
</tr>
<tr>
<td>Import Project</td>
<td></td>
</tr>
<tr>
<td>Backup Default Tables</td>
<td></td>
</tr>
</tbody>
</table>

**Create a new project and copies all records in the Tables to the new project. Model files are not copied.** Select the current project from the drop-down list and enter the name of the new project in the ‘To’ field. Click the ‘Copy’ button.

#### Delete a Project

<table>
<thead>
<tr>
<th>Action</th>
<th>Project Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Project</td>
<td></td>
</tr>
<tr>
<td>Delete Project</td>
<td></td>
</tr>
<tr>
<td>Rename Project</td>
<td></td>
</tr>
<tr>
<td>Backup Project</td>
<td></td>
</tr>
<tr>
<td>Import Project</td>
<td></td>
</tr>
<tr>
<td>Backup Default Tables</td>
<td></td>
</tr>
</tbody>
</table>

**Select the project from the drop-down list and click the ‘Delete’ button. All relevant records in the Tables are deleted. It is recommended to pack the Database to erase the deleted records from disk (see ‘Utilities’).**

#### Rename a Project

<table>
<thead>
<tr>
<th>Action</th>
<th>Project Management</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Project</td>
<td></td>
</tr>
<tr>
<td>Delete Project</td>
<td></td>
</tr>
<tr>
<td>Rename Project</td>
<td></td>
</tr>
<tr>
<td>Backup Project</td>
<td></td>
</tr>
<tr>
<td>Import Project</td>
<td></td>
</tr>
<tr>
<td>Backup Default Tables</td>
<td></td>
</tr>
</tbody>
</table>

**Use this function to change the name of a project. Select the project from the drop-down list and enter the new project name in the ‘To’ field. Click the ‘Rename’ button.**
Backup Project

Use this option to backup project data to one ‘zipped’ file. The backup file is saved to the backup subdirectory and has the project name with a ‘.zip’ extension.

Import Project

When the ‘Import’ button is clicked, a dialogue box appears for the user to select a project backup file (.zip extension). If the project already exists in the Database, a message appears to warn the user that all data in the current project will be deleted and replaced with the imported data. The user has the choice to continue or cancel.

Backup Default Tables

This option backs up the default data to a file ‘defaults.zip’ in the backup subdirectory. To restore the default data, copy the defaults.zip file to the data subdirectory and unzip the file.

This form can also be used to get rid of “orphans” in DDMSW by clicking on “Cleanup Tables”. Orphans records are records in a Table that do not belong to a Project ID.
The selection of Setup from the File Menu is used to edit System settings. These include:

- Agency name
- User’s name
- Path and file name to Adobe Acrobat Reader which is necessary to view help files.
- Path and file name for a text editor.
4. Hydrology

Rainfall

Prefre

The selection of Prefre from the Hydrology\Rainfall menu is used to edit data required for running the Prefre model and to run the model. The Prefre program computes the rainfall depths for the durations and return periods shown on the form. The user must enter appropriate values for all fields shown on the form. The selection of data can be obtained from the County’s Drainage Design Manuals.

Rainfall Pattern

The selection of Rainfall Pattern from the Hydrology\Rainfall menu is used to view the calculated rainfall pattern for the project. The data is calculated using procedures established in the County’s Drainage Design Manual and cannot be edited.
6 Hour Distribution Defaults

The selection of 6 Hour Distribution Defaults from the Hydrology\Rainfall menu is used to edit the default values for the rainfall patterns. The values should only be modified with caution as the default values are published by the County.

Soils

Data

The selection of Data from the Hydrology\Soil menu is used to add or edit soil data required for the Sub Basins.

The important values to enter are the Sub Basin ID which must match a Sub Basin ID in the Sub Basins Table, a Map Unit code, which will come from the Soil Defaults and the area for this soil. All of the remaining values can be calculated using the Update Data button.
There are three columns in the Soil Parameters section of the form. The first column, Value, is the value that will be used in the modeling analysis. The second column, Calc'd, is the calculated value based on the soil default values. The third column, Custom, ensures that a user entered value will not be overwritten with the calculated value when updating data.

**Defaults**

The selection of Defaults from the Hydrology\Soil menu is used to add or edit soil defaults required for the Sub Basins.

It is important to enter appropriate values for all fields as soil calculations for the entire project will be based on these values. When first entering this form for the project, if soil default data does not exist, the County’s default data is loaded into the system.

**Soil Surveys**

The selection of Soil Surveys from the Hydrology\Soil menu is used to add or edit soil surveys. This data is used to filter data on the Soil Data form.
Land Use

Data

The selection of Data from the Hydrology\Land Use menu is used to add or edit land use data required for the Sub Basins.

There are three columns in the Land Use Parameters section of the form. The first column, ‘Value’, is the value that will be used in the modeling analysis. The second column, ‘Default’, is the calculated value based on the land use default values. The third column, ‘Custom’, ensures that a user-entered value will not be overwritten with the calculated default value when updating data.

Defaults

The selection of Defaults from the Hydrology\Land Use menu is used to add or edit land use defaults required for the Sub Basins.
It is important to enter appropriate values for all fields as land use calculations for the entire project will be based on these values.

**Basins**

**Major Basins**

The selection of Major Basins from the Hydrology\Basins menu is used to add a new or edit an existing Major Basin.

Major Basins within a project are drainage basins that generally have a major outfall. Major Basins will have separate HEC-1 input files and their ID is designated by a **two character field**. Single digit numbers must therefore be preceded by a zero. Within a project, the first Major Basin ID is designated as “01”, the second as “02” etc. until Basin “99” is reached. If the number of basins exceeds ninety-nine, a new project must be started. It is necessary to have at least one Major Basin (01) in a project.

**Sub Basins**

The selection of Sub Basins from the Hydrology\Basins menu is used to add a new or edit an existing Sub Basin.

Sub Basins are drainage areas within a Major Basin. Sub Basin IDs are designated by a six character field **and must be unique within a project**. The preferred practice will be to designate the first two characters with the Major Basin ID and the remaining four characters in some systematic order.

Fields appearing on the Sub Basin form will vary depending on the defaults established in the project setup. For example if the Clark Unit Hydrograph is selected as the default, then the parameters for an S-Graph will not be available. There are three columns in the Rainfall Losses section of the form. The first column, Value, is the value that will be used in the modeling analysis. The second column, Calc’ed, is the calculated value based on the default values in Land Use and Soils. The third column, Custom, ensures that a user entered value will not be overwritten with the calculated value when updating data.
The selection of Routing from the Hydrology\Basins menu is used to add a new or edit existing Sub Basin or Reach routing data.

If Sub Basin is checked in the “Type” box at the top of the form, then Sub Basin routing data is available for editing. Likewise, if Reach is selected, then reach routing is available for editing. The Sub Basin ID must be unique and must match an ID in the Sub Basin data. The Reach ID must be unique within a project.
Distributions

Time-Area

The selection of Time-Area from the Hydrology\Distributions menu is used to edit Time-Area distributions used for the Clark Unit Hydrograph. Only data in the “Manual” column can be edited. Time-Area is only available if “Clark” is selected as the default unit hydrograph.

![Time-Area Relationships for Clark Unit Hydrograph]

S-Graph

The selection of S-Graph from the Hydrology\Distributions menu is used to edit S-Graph distributions used for the S-Graph Unit Hydrograph. Only data in the “Manual” column can be edited. S-Graph is only available if “S-Graph” is selected as the default unit hydrograph.

![S-Graph Coordinates]
Run HEC-1

This function runs the HEC-1 model for selected Major Basins within a project.

Highlight the Major Basin to model and select the appropriate return period. The results of the model run(s) will be place in a user defined directory established in the project defaults. The resultant file names will be distinguished by the Major Basin and return period being modeled.

The HEC-1 data is used for all return periods. When running the model, the appropriate rainfall data is inserted for the particular return period. When 'Update HEC-1 Data' is selected, the sub basin and routing data is updated from the relevant Tables in the Database.

*Note: DDMSW uses a special version of HEC-1 to facilitate data management. Using another version of HEC-1 will result in errors during the importing of final results.*
Edit HEC-1 Data

This selection allows the user to add a new HEC-1 file or edit an existing Major Basin HEC-1 file within a project.

The data in this file can be exported to an ASCII file to facilitate editing by clicking on the “Export” button and following the instructions on the screen. When finished with the editing, the file can be imported by clicking on the “Import” button. Importing replaces the existing data for the selected Major Basin. To view a different Major Basin’s data, use the Major Basin pull-down menu.

View Summary Results

This displays summary results of model runs. The data cannot be edited.

Clicking on “Hydrograph, Routed, Combined or All”, will filter the data to the selection. The data can also be ordered by “Sub Basin or Numeric” where Numeric is the natural order from the model results.
View Output File

Select a file from the file selection dialogue box. The text editor opens the ASCII model output file. When finished viewing, close the window by clicking [x], otherwise the text editor program will remain loaded in memory.

Develop Draft Model Data

The selection of Develop Draft Model Data from the Hydrology\HEC-1 menu is used to develop draft HEC-1 data from the Sub Basin and default data used in the project. The program will replace any existing data for the selected Major Basin in the HEC-1 data file and should only be used at the beginning of a project. The program requires the Sub Basin data to be available. If “Create Draft Routing Cards” is selected, available routing data will be appended to the draft file. It will be up to the user to place the routing cards in the appropriate location.
5. Hydraulics

To be developed
6. GIS

To be developed
Export Data

The selection of Export Data from the Utilities menu is used to export a Table from the Database to a file in a different format. All the record data in the Table are exported. Note that the Table contents are not removed, but are copied to a different file format. The file formats supported include:

**CSV**  Data is exported into a file one record per line, with each field separated by a comma. Character fields are enclosed in quotes. For example:

```
projectid,landuse,drainage,vegcover,rtmp,ia,ka,kbdesc,group,descript,c10,ia_desc,sort
"BETA010","M","Dry",25.0,0.25,0.050,"Max","","MOUNTAIN",0.00,"",10
"BETA010","H","Dry",30.0,0.15,0.040,"Hi","","HILLSLOPE",0.00,"",20
"BETA010","D","Dry",30.0,0.35,0.030,"Low","","DESERT RANGELAND",0.00,"",30
```

**TXT**  Data is exported one record per line in ASCII text that can be read by any text editor. The data is in fixed format (columns). For example:

```
BETA010  H  Dry  25.0 0.250 0.050Max MOUNTAIN
BETA010  H  Dry  30.0 0.150 0.040Hi HILLSLOPE
BETA010  D  Dry  30.0 0.350 0.030Low DESERT RANGELAND
```

**DBF**  Exports data into a format that can be read by a Database program such as Dbase or FoxPro.

**XLS**  Select this type to create an spreadsheet which can be opened in Microsoft Excel.
Use the mouse to highlight the Table and select an export type from the drop down selection box, then click ‘Export’. The contents (all records) of the selected Table is saved on disk in the chosen format. The user is prompted to enter a filename and location for the export file.

Import Data

The selection of Import Data from the Utilities menu is used to import data originating from another source, such as a spreadsheet, text file or another database, into a selected table. The file formats supported include CSV, TXT, DBF, and XLS, as described in ‘Export Data’. There are two options:

- Append to Existing Data: This option adds the data to the existing data. The results will include the current and the newly imported data.

- Replace Existing Data: This option deletes the current data in the table, and then replaces it with the new data.

It is important that the data to be imported has the same structure as the importing Table, otherwise fields will be truncated and records rejected. For this reason, a
good practice is to first export a Table and then use the exported file as a template for the acceptable format.

Highlight the Table to append or replace, select the file type and click ‘Import’. The following dialogue box appears for the user to select the file to import. Highlight the filename and click ‘OK’.

Pack Tables

This function rebuilds the Table indexes, and then packs all Tables in the Database. Packing is the process of **permanently removing records** that have been marked for deletion. Once a Table is packed, records cannot be recovered. Packing recoups disk space occupied by deleted records. It should not be necessary to pack the Database frequently, but on occasion after many records have been deleted over time.

Caution: Packing Tables take a few minutes to complete. Do not interrupt the process once it has begun.

Table Descriptions

The selection of Table Descriptions from the Utilities menu is used to view the name and description of Tables used in the application. The data cannot be edited.

Field Descriptions

The selection of Field Descriptions from the Utilities menu is used to view the structure of each Table used in the application. The data cannot be edited.
Import DOS Family

The selection of Import DOS Family from the Utilities menu is used to import data developed in the DOS version of DDMS.

Enter a Project ID, title and location for the data to be imported. This is the same information as starting a new project. Click the “Import” button. The program will import data as follows:

- Sub Basin Area data
- Default Land Use data
- Sub Basin Land Use data
- Sub Basin Soil data
- Hydrograph Type
- Precipitation data
- Storms, duration, Timearea, NMIN
- From a file with an .SBR extension
- From a file with an .LDF extension
- From a file with an .SUB extension
- From a file with an .SUB extension
- From a file with an .SUB extension
- From a file with an .PFI extension
- From either *M1I or *M2I

If the above files are not available for the “family”, then not all of the required data will be imported and the remaining required data will have to be entered manually into the Database.
8. Help and Window

Help

About
This displays the informational screen for the application.

Help
This option on the Help menu displays a list of manuals that the user can view. Highlight a manual and click Help. Acrobat reader opens the manual on the screen. When finished viewing, close the Acrobat screen otherwise it will remain open on the desktop. (The path to Acrobat Reader must be entered in System Setup.)

Window

Two options are available on the Window Menu.

Arrange All
Use this to cascade all open forms on the screen. Alternatively, the user can press ‘Ctrl T’ at any time to arrange forms.

Close All
Use this to close all open forms. Pressing ‘Ctrl A’ has the same effect.
Example

Introduction

There are a number of Projects that have been used to test the application. The data in these projects can be reviewed by importing the Project to see how data is entered for the various type of default settings. The following are the default values for the various Beta Projects:

<table>
<thead>
<tr>
<th>Project ID</th>
<th>Hydrograph</th>
<th>Storms</th>
<th>Duration</th>
<th>Loss Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>KVLTEST1</td>
<td>Clark</td>
<td>Single</td>
<td>6 Hour</td>
<td>Green-Ampt</td>
</tr>
<tr>
<td>BETA010</td>
<td>Clark</td>
<td>Single</td>
<td>6 Hour</td>
<td>Green-Ampt</td>
</tr>
<tr>
<td>BETA020</td>
<td>S-Graph</td>
<td>Single</td>
<td>6 Hour</td>
<td>Green-Ampt</td>
</tr>
<tr>
<td>BETA030</td>
<td>Clark</td>
<td>Single</td>
<td>6 Hour</td>
<td>Init &amp; Uniform</td>
</tr>
<tr>
<td>BETA040</td>
<td>S-Graph</td>
<td>Single</td>
<td>6 Hour</td>
<td>Init &amp; Uniform</td>
</tr>
<tr>
<td>BETA050</td>
<td>Clark</td>
<td>Single</td>
<td>24 Hour</td>
<td>Green-Ampt</td>
</tr>
<tr>
<td>BETA060</td>
<td>S-Graph</td>
<td>Single</td>
<td>24 Hour</td>
<td>Green-Ampt</td>
</tr>
<tr>
<td>BETA070</td>
<td>Clark</td>
<td>Single</td>
<td>24 Hour</td>
<td>Init &amp; Uniform</td>
</tr>
<tr>
<td>BETA080</td>
<td>S-Graph</td>
<td>Single</td>
<td>24 Hour</td>
<td>Init &amp; Uniform</td>
</tr>
<tr>
<td>BETA090</td>
<td>Clark</td>
<td>Multiple</td>
<td>6 Hour</td>
<td>Green-Ampt</td>
</tr>
<tr>
<td>BETA100</td>
<td>S-Graph</td>
<td>Multiple</td>
<td>6 Hour</td>
<td>Green-Ampt</td>
</tr>
<tr>
<td>BETA110</td>
<td>Clark</td>
<td>Multiple</td>
<td>6 Hour</td>
<td>Init &amp; Uniform</td>
</tr>
<tr>
<td>BETA120</td>
<td>Clark</td>
<td>Multiple</td>
<td>24 Hour</td>
<td>Green-Ampt</td>
</tr>
<tr>
<td>BETA130</td>
<td>S-Graph</td>
<td>Multiple</td>
<td>24 Hour</td>
<td>Green-Ampt</td>
</tr>
</tbody>
</table>

Establish a New Project (KVLTest1)

The steps to establish a new project through to running the HEC-1 model and viewing the results are as follows:

1. Establish Path for Model Runs
2. Create New Project and Establish Defaults
3. Establish Rainfall Data for Project
4. Establish Land Use Defaults
5. Establish Soil Defaults
6. Establish Land Use Data
7. Establish Soil Data
8. Establish Major Basin
9. Establish Sub Basin Data
10. Establish Routing Data
11. Develop Draft HEC-1 Input File
12. Edit Draft HEC-1 Input File
13. Run HEC-1 Model
14. View Model Summary Results
1. Establish Path for Model Runs
Create a folder for the HEC-1 model runs. For this example, a new folder C:\ddmsw\kvltest1 has been created.

2. Create New Project and Establish Defaults
Select New from the File Menu and fill in data for Title and Hydrology defaults.
3. Establish Rainfall Data for Project

Select *Prefre* from the *Hydrology\Rainfall Menu*. Fill in data shown below.

Click *Run Prefre* to run the Prefre model and establish rainfall data as shown below.
4. Establish Land Use Defaults

Select *Defaults* from the Hydrology\Land Use Menu. The first time you come to this screen, it will look like the following screen. This screen will look different if “Green-Ampt” is not the default Loss Method.

Click ![to create a new record and fill in the data for the first record as shown below. Use appropriate Tables in the County’s Drainage Manual for reference.](image)

To add new records either create a new record as just described or click ![Copy Record](image) (use Browse to view data) and edit the data for the new record.
5. Establish Soil Defaults

Select Defaults from the Hydrology\Soil Menu. If Soil Default data does not exist for this project, then the County default Table will be loaded. The user can then modify the data to establish different defaults to be used for this project. If it is necessary to add new data, then do it in the same manner as adding new records for the Land Use Defaults. The following view is shown in Browse mode.

6. Establish Land Use Data

Select Data from the Hydrology\Land Use Menu. Add or Copy records to populate the necessary data as shown below. It is only necessary to add the Sub Basin ID, select the Land Use and add the Area in square miles. Then click Update Data to populate the Default Values. If a non-default value is used, it will be necessary to check the adjacent Custom box. Values with adjacent Custom box checked will not be updated.

Be sure to enter land use data for each Sub Basin ID in this Project and make sure there is sufficient land use data to cover the entire Sub Basin.
7. Establish Soil Data

Select *Data* from the *Hydrology*|*Soil* Menu. Add or Copy records to populate the necessary data as shown below. It is only necessary to add the Sub Basin ID, select the Map Unit and add the Area in square miles. Then click *[Update Data]* to populate the Default Values. If a non-default value is used, it will be necessary to check the adjacent Custom box. Values with adjacent Custom box checked will not be updated.

Be sure to enter soil data for each Area ID in this Project and make sure there is sufficient soil data to cover the entire Area ID’s area.

8. Establish Major Basin

Select Major Basins from the *Hydrology*|*Basins* Menu. Add or Copy records to populate the necessary data as shown below. Each hydrology model run will be for a unique Major Basin ID. Select 01 for the first basin, 02 through 99 for other Major Basins.
9. Establish Sub Basin Data

Select *Sub Basins* from the *Hydrology\Basins* Menu. Add or Copy records to populate the necessary data as shown below. Forms may look different depending on the established project defaults. To populate the remaining data, click “Update Data”. This updates all records for the Sub Basin data for this Project.

```
<table>
<thead>
<tr>
<th>Project ID</th>
<th>Area (sq mi)</th>
<th>Length (mi)</th>
<th>Slope (%m)</th>
<th>Time-Area</th>
<th>K2</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>0.500</td>
<td>0.660</td>
<td>10.0</td>
<td>Urban</td>
<td>0.046</td>
</tr>
</tbody>
</table>
```

Following the Update Data, if there are any errors or values falling outside standards, then a report will come to the screen that can be printed. Review this report to see what needs to be fixed.

10. Establish Routing Data

Select *Routing* from the *Hydrology\Basins* Menu. Add or Copy records to populate the necessary data as shown below. Forms may look different depending on the established project defaults.

```
<table>
<thead>
<tr>
<th>Project ID</th>
<th>Type</th>
<th>Sub Basin</th>
<th>Reach</th>
<th>L (ft)</th>
<th>S (ft/ft)</th>
<th>N</th>
<th>TWAPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>REACH</td>
<td>01</td>
<td>10</td>
<td>3030.0</td>
<td>0.0640</td>
<td>0.030</td>
<td>20.0</td>
</tr>
</tbody>
</table>
```
11. Develop Draft HEC-1 Input File

Select **Develop Draft Model Data** from the **Hydrology\HEC-1** Menu. Select the appropriate Major Basin and check whether or not to create Draft Routing Cards. Click on “Create Draft”.

![Draft Model Data](image1)

12. Edit Draft HEC-1 Input File

Select **Edit HEC-1 Data** from the **Hydrology\HEC-1** Menu. Select the appropriate Major Basin ID.

![HEC-1 Data](image2)

The best way to edit this data is to export the file to an ASCII file and edit the data and then import the ASCII file when edits are complete. Click “Export” to export the file. A dialogue box comes up with the default model runs path and the Basin ID. Click save.

![Export File](image3)
The following is an example of the draft HEC-1 ASCII file (note the routing cards are at the bottom).

```

Finally after editing the ASCII file it can be imported. Click Import and select the appropriate file to import. A dialogue box comes up for the selection.

```
13. Run HEC-1 Model
Select *Run HEC-1* from the *Hydrology\HEC-1* Menu. Select the appropriate Major Basin ID and Return Period and click *Run Model*.

14. View Model Summary Results
Select *View Summary Results* from the *Hydrology\HEC-1* Menu.

Alternatively, the output file can be viewed in its original format by selecting *View Output File* from the *Hydrology\HEC Model*.